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Chapter 1: Introduction

Avid® HD 1/0 is a multi-channel digital audio
interface designed for use with Avid HDX, Avid
HD Native, and Pro Tools|HD hardware. HD I/0
features 24-bit analog-to-digital (A/D) and dig-
ital-to-analog (D/A) converters, and supports
sample rates of up to 192 kHz.

HD I/0 comes in three standard configurations:

+ 8x8x8(8analogin, 8 analog out, and 8
digital in and out)

« 16 x 16 analog in and out
+ 16 x 16 digital in and out
You can also add or remove analog (ADC and

DAC) and digital cards for custom configura-
tions.

HD 1/0 Features

HD I/0 provides up to sixteen discrete channels
of audio input and output, each with a four-seg-
ment LED meter. The total available analog and
digital I/0 is dependent on the configuration of
Analog and Digital Expansion I/0 cards in-
stalled in HD 1/0.

Analog 1/0

« Up to 16 channels of 24-bit D/A and A/D con-
verters for superior analog input and output at
sample rates of 44.1 kHz, 48 kHz, 88.2 kHz,
96 kHz, 176.4 kHz, and 192 kHz with Analog
In and Analog Out HD I/0 cards

« Soft Clip and Curv limiting circuits to protect
against clipping on analog input

Digital 1/0

« Up to 16 channels of 24-bit digital I/0, using
AES/EBU, TDIF DB-25, or Optical at sample
rates of 44.1, 48, 88.2, 96, 176.4, and 192 kHz
with a Digital HD I/0 card

+ Real-time sample rate conversion on digital
inputs with a Digital I/O card (up to sixteen
channels of AES/EBU, Optical, or TDIF)

« Support for S/MUX Optical for sample rates of
88.2 kHz and higher

o Support for 2 channels of S/PDIF Optical (en-
closed) with sample rates of up to 96 kHz

« 2 channels of AES/EBU I/0 (enclosed) with
support for sample rates up to 192 kHz

o 2 channels of 24-bit-capable S/PDIF I/0O (en-
closed) with support for sample rates up to
192 kHz

Chapter 1: Introduction
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Synchronization
« Loop Sync input and output for connecting ad-

ditional Avid HD audio interfaces and periph-
erals

« External Clock input and output for synchro-
nizing HD I/0 with external Word Clock de-
vices

Expandability
« Optional addition of I/O cards to expand ana-

log or digital I/0

« Simultaneous use of multiple Avid HD audio
interfaces to further expand system input and
output

What’s Included
« Avid HD 1/0 audio interface
« AC power cable
 DigiLink Mini cable (18 inches [0.46m])
« DigiLink Mini adapter
o BNC cable (18 inches [0.46m])
« HD I/O Guide
o Health and Safety Guide

+ Registration Information Card

HD I/O Guide

System Requirements and
Compatibility

Avid can only assure compatibility and provide
support for hardware and software it has tested
and approved.

For complete system requirements and a list of
qualified computers, operating systems, hard
drives, and third-party devices, visit:

www.avid.com/compatibility

Registration

Review the enclosed Registration Information
Card and follow the instructions on it to quickly
register your purchase online. By registering,
you become eligible to receive the following:

o Technical support information
« Software update and upgrade notices

o Hardware warranty information

Hardware Warranty

Your warranty can be found on the Registration
Information Card.



About This Guide

This guide provides a basic overview of
HD /0 features and functionality.

For hardware installation instructions for your
HDX hardware, see the HDX Install Guide.

For hardware installation instructions for your
HD Native hardware, see the HD Native Install
Guide.

For hardware installation instructions for your
Pro Tools|HD hardware, see the Pro Tools|HD
User Guide.

For Pro Tools software installation instructions,
see the Pro Tools Installation Guide.

For additional information about using

Pro Tools software, see the Pro Tools Reference
Guide (in Pro Tools, choose Help > Pro Tools
Reference Guide).

Conventions Used in This Guide

All of our guides use the following conventions
to indicate menu choices and key commands:

Convention Action
File > Save Choose Save from the
File menu
Control+N Hold down the Control key
and press the N key
Control-click Hold down the Control key
and click the mouse button
Right-click Click with the right
mouse button

The names of Commands, Options, and Settings
that appear on-screen are in a different font.

The following symbols are used to highlight
important information:

Q User Tips are helpful hints for getting the

most from your system.

A\ Important Notices include information that
could affect your data or the performance of
your system.

Shortcuts show you useful keyboard or
mouse shortcuts.

Cross References point to related sections in
this guide and other Pro Tools guides.

Chapter 1: Introduction




About www.avid.com

The Avid website (www.avid.com) is your best
online source for information to help you get the
most out of your Pro Tools system. The follow-
ing are just a few of the services and features
available.

Product Registration Register your purchase
online.

Support and Downloads Contact Avid Customer
Success (technical support); download software
updates and the latest online manuals; browse
the Compatibility documents for system re-
quirements; search the online Knowledge Base
or join the worldwide Pro Tools community on
the User Conference.

Training and Education Study on your own using
courses available online or find out how you can
learn in a classroom setting at a certified

Pro Tools training center.

Products and Developers Learn about Avid

products; download demo software or learn
about our Development Partners and their

plug-ins, applications, and hardware.

News and Events Get the latest news from Avid
or sign up for a Pro Tools demo.

4 HD /O Guide



Chapter 2: HD 1/O Overview

This chapter describes the front and back panel features of the HD I1/0.

HD 1/0 Front Panel

HD 1/O Front Panel

Power Switch and LED Ring

This button turns HD I/0 on and off. The LED
ring around the power button will light green or
orange to indicate the system status:

Green LED Ring Indicates that the unit has pow-
ered up successfully and is connected to an ac-
tive system.

Orange LED Ring Indicates that the unit has
power, but the computer it is connected to is
shut down.

Sample Rate

These LEDs display the current sample rate of
the HD I/0 internal clock: 44.1 kHz, 48 kHz,
88.2 kHz, 96 kHz, 176.4 kHz, or 192 kHz. The
sample rate can be set in Pro Tools when you
create a new session, or in the Hardware Setup
or Playback Engine dialogs if no session is open.

Chapter 2: HD 1/O Overview 5



Loop Master LED

The LOOP MASTER LED indicates which audio
interface is the master peripheral. The Loop
Master LED will be continuously lit on the cur-
rent Loop Master peripheral only, and unlit on
all other peripherals. (Only one Avid HD periph-
eral can be Loop Master at a time.) The Loop
Master LED will always be lit with a single inter-
face.

With HDX hardware, Loop Master defaults to
the first audio interface connected to DigiLink
Mini Port 1 on the first card in the system.

With HD Native hardware, Loop Master defaults
to the first audio interface connected to Digi-
Link Mini Port 1 on the HD Native card.

For Pro Tools|HD systems, Loop Master defaults
to the first audio interface connected to the pri-
mary, or “core” Pro Tools|HD card. On

Pro Tools|HD (for PCle), this is the Accel Core

card. On Pro Tools|HD (for PCI), this is the HD
Core card.

Sync Mode LEDs

The SYNC MODE LEDs indicate the current
Clock Source as set in Pro Tools.

INT (Internal) Indicates the HD I/0 sample clock
is generated by its internal clock, as determined
by the session Sample Rate.

DIG (Digital) Indicates that an external
AES/EBU, TDIF, Optical (ADAT), Optical
(ADAT S/MUX), or S/PDIF device is providing
system clock. If no valid clock source is de-
tected, HD I/0 will switch to internal clock, the
DIG LED will flash, and an error message will
appear on-screen in Pro Tools.

LOOP Indicates that the HD I/0 is slaving to an-
other Avid HD audio interface or SYNC periph-
eral using Loop Sync.

6 HD I/O Guide

EXT (External) Indicates that the HD 1/0 is using
the EXT CLOCK IN port for system synchroniza-
tion.

When synchronized to Word Clock, External
Clock input and output do not have to be at the
Word Clock rate. EXT CLOCK IN synchroniza-
tion will typically be 1x the current session sam-
ple rate. However, for sample rates higher than
48 kHz, HD I/0 generates a choice of 1x, 2x, or
4x of a base rate of 44.1 kHz or 48 kHz, as
follows:

Session Sample Rate | Word Clock Support
44.1 kHz 44.1 kHz
48 kHz 48 kHz
88.2 kHz 88.2 kHz
44.1 kHz
96 kHz 96 kHz
48 kHz
176.4 kHz 176.4 kHz
44.1 kHz
192 kHz 192 kHz
48 kHz
Meters

These four-segment LEDs indicate signal level
for each of the sixteen channels. The top row of
meters indicates input levels, and the bottom
row shows output levels. These meters are cali-
brated at -42 dB, -18 dB, -6 dB, and 0 dB,
respectively.

Q Note that 0 dB is not to be confused with
" clipping; use the on-screen meters in
Pro Tools to determine whether a signal is

clipping.



HD 1/0 Back Panel

Bay 1: Analog In card

“DiGITAL 10

Bay 3: Digital I/O card

Enclosure

Bay 2: Analog Out card

HD I/0 Back Panel, 8 x 8 x 8 configuration shown

Although the HD 1/0 is a sixteen-channel audio
interface, it has up to 94 inputs and outputs
available through its various back panel
connectors.

HD I/0 comes in three standard configurations:

+ 8x 8x 8 analog and digital in and out
« 16 x 16 analog in and out

« 16 x 16 digital in and out

Bay 4: Empty for Optional card

Input and Output Cards

The HD I/0 features four bays for HD I/0
Expansion cards. With the standard 8 x 8 x 8
configuration, bays 1-3 contain Analog In, An-
alog Out, and Digital I/0 cards, respectively.
The fourth bay (as shown in this 8 x 8 x 8 config-
uration) is an expansion bay, for which you can
purchase an additional Expansion I/0 card of
your choice.

By installing an optional AD Expansion card,
DA Expansion card, or Digital Expansion card,
you can add even more I/O capacity (up to a
maximum possible 110 inputs and outputs). See
Chapter 5, “Adding or Removing I/0 Cards.”

A\ Input and Output cards for 192 1/0 are not
supported in HD I/0.

Chapter 2: HD 1/O Overview 7



Analog Input

The HD I/0 Analog In card contains connectors
for analog audio input with 24-bit, 192 kHz A/D
converters. Input is provided through two dis-
crete DB-25 connectors (one for +4 dBu
sources, and the other for -10 dBV sources).
You can connect sources at both operating levels
and choose between them from within

Pro Tools.

+4 dBu Balanced Provides eight balanced input
channels at +4 dBu nominal operating levels.

—10 dBV Balanced Provides eight balanced input
channels at -10 dBV nominal operating levels.

Q Most consumer electronics operate at -10 dBV
" levels, and may not feature balanced inputs
and outputs. You can connect —-10 dBV signals
to the —10 dBV inputs, but you will need to
make sure that the negative terminals are not
connected.

For wiring information, see Chapter 6, “Pinout
Diagrams for the DB-25 Connectors.”

For each channel, you can select input level from
within the Hardware Setup dialog (see “Hard-
ware Setup” on page 21).

Input Trims

The Input Trims below the DB-25 connectors
are used to individually calibrate each channel’s
input level. See “Input Trims” on page 30.

Additionally, the Limiter function helps avoid
digital clipping (see“Limiter” on page 26).

8 HD I/O Guide

Analog Output

The HD I/0 Analog Out card contains a single
DB-25 connector and Output Trims for eight
channels of analog audio output. These balanced
outputs operate at +4 dBu levels. See Chapter 6,
“Pinout Diagrams for the DB-25 Connectors.”

Q For =10 dBV gear, you can switch a jumper
"~ on Analog Output cards (on a channel-by-
channel basis) from the default Hi position
to Lo for a -6 dB pad. You can then adjust
the Trim pot for the corresponding output
channels by an additional -4 dB to accom-
modate —10 dBV gear. For more informa-
tion, see Chapter 7, “HD I/O Calibration
Mode Instructions.”

Output Trims

The Output Trims below the DB-25 connector
are used to individually calibrate each channel’s
output level. For more information, see
Chapter 7, “HD I/0 Calibration Mode Instruc-
tions.”



Digital 1/0

The Digital I/O card contains connectors for
eight channels each of AES/EBU 1/0, TDIF 1/0,
and Optical (ADAT) I/0. Only one digital format
can be used at a time.

AES/EBU DB-25 connectors for eight channels
of AES/EBU input and output. Each of the paired
channels is a balanced three-conductor signal,
and supports 192 kHz sample rates in single-
wire mode up to eight channels. Dual-wire mode
uses two HD I/0 physical I/0 channels of
AES/EBU /0 to carry each single stream of
176.4 kHz or 192 kHz audio. Therefore, only
four simultaneous channels of AES/EBU I/0 are
available at 176.4 kHz or 192 kHz.

TDIF DB-25 connectors for eight channels of
TDIF input and output. Conforms to standard
eight-channel TDIF pinouts. For more informa-
tion, see Chapter 6, “Pinout Diagrams for the
DB-25 Connectors.”

Q We recommend using Avid DB-25 TDIF
cables for optimum compatibility.

Optical (ADAT) Dedicated, eight-channel 24-bit
capable Optical ports (up to 48 kHz), with real-
time sample rate conversion on input (only).
Note that Optical S/PDIF is not supported with
the Digital I/0 card and is supported with the
enclosed Optical ports only (for more informa-
tion, see “Optical (ADAT) [Encl]” on page 10).

The inputs on the Digital I/O card feature real-
time sample rate conversion. For example, you
can stream audio with a sample rate of 44.1 kHz
into a 96 kHz session.

For more information, see“Hardware Setup”
on page 21.

Enclosure Connectors

The right half of the back panel of HD 1/0 fea-
tures a set of non-removable connectors that are
mounted to the enclosure.

These connectors include two channels of
AES/EBU 10, Optical I/0 (for another eight
channels of ADAT format, or two channels of
Optical S/PDIF), and two channels of coaxial
S/PDIF 1/0. On-screen, these connectors are
identified as AES/EBU [Encl], Optical (ADAT)
[Encl], Optical (S/PDIF) [Encl], and S/PDIF
[Encl].

Other connectors include Loop Sync, External
Clock, and ports for attaching the HD I/0 to
HDX, HD Native, or Pro Tools|HD cards, or to
other Avid HD audio interfaces.

Chapter 2: HD 1/O Overview



AES/EBU [Encl]

These are balanced, three-conductor XLR con-
nectors that accept and output a stereo, 24-bit
AES/EBU audio signal. These two ports support
up to 192 kHz sample rates.

Optical (ADAT) [Encl]

These Optical ports provide up to eight channels
of Optical (ADAT) input and output, or two
channels (stereo) optical S/PDIF input and out-
put. Optical (ADAT) mode supports sample
rates up to 48 kHz. Using S/MUX, these Optical
ports support provide up to four channels of Op-
tical S/MUX input and output at sample rates of
88.2 and 96 kHz, and up to two channels of Op-
tical S/MUX input and output at sample rates of
176.4 and 192 kHz. In TOS-Link mode, the ports
support two channels of Optical input and out-
put at sample rates up to 96 kHz.

Q Configure HD I/0 for ADAT S/MUX on the
"~ enclosed ADAT port and also on the ADAT
port on the Digital I/O card to get 8 channels
at 88.2/96 kHz or 4 channels at
176.4/192 kHz.

About Lightpipe-Compatible Devices

Lightpipeis an industry standard, eight-channel
optical digital audio connection created by Ale-
sis. Lightpipe is found on many devices, includ-
ing Optical (ADAT) decks, modular digital mul-
titracks (MDMs), A/D or D/A converters,
S/MUX, and digital consoles.

10 HD I/O Guide

S/PDIF Digital In and Out

These are unbalanced RCA jacks that receive
and send two channels of S/PDIF audio. S/PDIF
supports up to 24-bit audio, at sample rates up
to 192 kHz.

Q To maintain data integrity and minimize
" jitter, use only 75-ohm coaxial cable for
S/PDIF connections.

DigiLink Mini Ports

PRIMARY PORT

Use the PRIMARY PORT to connect HD I/0 to
HDX or HD Native cards using a DigiLink Mini
cable, or to Pro Tools|HD cards using a DigiLink
cable with a DigiLink Mini adapter.

The Primary port sends and receives 32 chan-
nels to and from an HDX, HD Native, or

Pro Tools|HD card. Input and output channels
17-32 (if active) are passed through to the EX-
PANSION PORT.

EXPANSION PORT

The EXPANSION PORT lets you connect an ad-
ditional Avid HD audio interface to HD 1/0. The
EXPANSION PORT passes input and output
channels 17-32 to the expansion (or secondary)
audio interface.

This port is only available when HD I/0 is con-
nected directly to an HDX, HD Native, or

Pro Tools|HD card. It is not available when the
HD I/0 is connected to the Expansion Port on
another audio interface.



DigiLink Mini Cables and Adapters

Avid provides various cables and adapters to
connect Avid HD audio interfaces to HDX,
HD Native, and Pro Tools|HD cards.

For more information about DigiLink Mini
cables and adapters, visit the Avid website
(www.avid.com).

DigiLink Mini Cables

Use a DigiLink Mini cable to connect an HD I/0
to an HDX or HD Native card, or to other Avid
HD audio interface (such as another HD I/0 or
HD OMNT).

There are five different lengths of DigiLink Mini
cables:

e 187(0.46m)

o 12°(3.6m) (sold separately)
e 25°(7.62m) (sold separately)

e 50’ (15.25m), the maximum length sup-
ported for 176.4 kHz and 192 kHz sessions
(sold separately)

« 100’ (30.5m), the maximum length sup-
ported by 88.2 kHz and 96 kHz sessions
(sold separately)

DigiLink Mini Adapters

Use a DigiLink cable with a DigiLink Mini
adapter to connect HD I/0 to a Pro Tools|HD
card. You can also use a DigiLink Mini adapter
to connect HD 1/0 to legacy Pro Tools|HD audio
interfaces (such as 192 1/0).

There are two types of DigiLink Mini adapters:
« 12” DigiLink Mini female to DigiLink male
« 127 DigiLink Mini male to DigiLink female

Clock and Synchronization Ports

WD CLOCK IN and OUT

The Word Clock I/0 ports are standard BNC
connectors that receive and output word clock
signal. These ports can be used to synchronize
HD 1/0 with any word clock-capable device.

Word Clock In can be configured by selecting it
as the Clock Source in the Hardware Setup dia-
log in Pro Tools. Word Clock Out can also be
configured in the Hardware Setup dialog using
the External Clock Output selector.

Q Because crucial timing data is passed
through the Loop Sync and Word Clock
ports, you should use high-quality, 75-Ohm
RG-59 cables for making connections.

Chapter 2: HD 1/O Overview 11
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LOOP SYNC In and Out

Loop Sync is a dedicated clock loop for synchro-
nizing multiple Pro Tools|HD peripherals to-
gether (multiple audio interfaces, ora SYNC HD
and one or more audio interfaces). Loop Sync
technology lets you synchronize to any digital
peripheral connected to any of the Pro Tools|HD
audio interfaces in your Pro Tools system. Loop
Sync uses a word clock signal based on sample
rates of either 44.1 kHz or 48 kHz. As sample
rate increases in the system, Loop Sync contin-
ues to operate at a base rate of 44.1 kHz or

48 kHz, depending upon the higher rate.

The Loop Sync In and Out ports are standard
BNC connectors that output a 1x Word clock sig-
nal. Loop Sync should only be used to chain mul-
tiple Pro Tools|HD peripherals together (such as
Pro Tools|HD audio interfaces and SYNC HD).

AC Power

This connector accepts a standard AC power ca-
ble. HD I/0 is auto power-selecting (100V to
240V) and will automatically work with a stan-
dard modular cable (IEC) to connect to AC
power outlets in any country.

Accessory Port

This port currently has no functionality.

HD I/O Guide



Chapter 3: Connecting HD 1/0

HD 1/0 provides up to sixteen channels of ana-
log and digital I/0 with HD 1/O with Avid HDX,
HD Native, or Pro Tools|HD hardware.

HDX With HDX hardware, HD I/0 is connected
to the HDX card using a DigiLink Mini cable.
You can connect additional HD audio interfaces
to your system using the Expansion port on the
back of HD 1/0, the second DigiLink Mini Port
on the HDX card, or by using additional HDX
cards. See “Connecting HD I/0 to HDX Cards”
on page 14.

For more information about installing HDX
cards, see the HDX Install Guide.

HD Native With HD Native hardware, HD I/0 is
connected to the HD Native card using a
DigiLink Mini cable. You can connect additional
HD audio interfaces to your system using the
Expansion port on the back of HD I/0 or the sec-
ond DigiLink Mini Port on the HD Native card.
See “Connecting HD 1/0 to an HD Native Card”
on page 16.

For more information about installing the
HD Native card, see the HD Native Install
Guide.

Pro Tools|HD With Pro Tools|HD hardware,
HD /0 is connected to a Pro Tools|HD card
using a DigiLink cable with a DigiLink Mini
adapter. You can connect additional HD audio
interfaces to your system using the Expansion
port on the back of HD I/0 or using additional
Pro Tools|HD cards. See “Connecting HD 1/0 to
Pro Tools|HD Cards” on page 18.

For more information about installing
Pro Tools|HD cards, see the Pro Tools|HD
User Guide.

Rack Mounting HD Audio Interfaces

HD 1/0 and all Avid HD audio interfaces need
room at their sides to maintain proper air flow
for cooling. Do not block the sides of the unit or
disconnect the internal fan. If the units are rack-
mounted in a case, remove the case lids or doors
before operating the system. Failure to do so can
result in the units overheating very quickly,
which can permanently damage sensitive
components.

Chapter 3: Connecting HD 1/O
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Connecting HD 1/O to HDX Cards

Each HDX card supports up to 64 channels of audio input and output. To get a full 64 channels of I/0,
you can connect up to four 16-channel HD I/0 to an HDX card. Two of the interfaces connect directly
to DigiLink Mini Ports 1 and 2, and the other two HD I/O connect to the Expansion ports on first two

HD I/0.

To connect HD I/O to an HDX card:

= Connect the HD I/0 Primary Port to DigiLink Mini Port 1 on the HDX card using a DigiLink Mini
cable.

Figure 1. HD I/O connected to the DigiLink Mini Port 1 on an HDX card

To connect additional HD I/O audio interfaces:

1 After connecting the primary audio interface,
connect additional HD I/0O (or other compatible
audio interfaces) by doing one of the following:

o Connect the Primary Port of the secondary
interface to the Expansion Port of the pri-
mary interface with a DigiLink Mini cable.

o Connect the Primary Port of the secondary

interface to DigiLink Mini Port 2 on the
HDX card.

2 Repeat the preceding with additional HDX
cards.

3 Make the necessary Loop Sync connections
(see “Connecting Loop Sync” on page 14).
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Connecting Loop Sync

If you are using two or more HD audio interfaces
or a SYNC peripheral, Loop Sync must be con-
nected to maintain proper clock synchroniza-
tion among the devices. For an example of con-
necting multiple Avid HD audio interfaces, see
Figure 2 on page 15. For examples that include a
SYNC peripheral, see the SYNC HD Guide.

To make Loop Sync connections:

1 Connect the Loop Sync Out of each interface to
the Loop Sync In of the next interface with a BNC
cable.

2 Connect the Loop Sync Out of the last interface
to the Loop Sync In of the primary interface or
SYNC peripheral with a BNC cable.



First HDX card

Second HDX card

Figure 2. Making DigiLink and Loop Sync connections with two HDX cards, one HD OMNI, and five HD 1/Os
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Connecting HD 1/O to an HD Native Card

To connect HD I/O to an HD Native card:

= Connect the HD I/0 Primary Port to DigiLink Mini Port 1 on the HD Native card using the included
DigiLink Mini cable.

Figure 3. HD 1/O connected to the DigiLink Mini Port 1 on an HD Native card

To connect two HD I/Os to an HD Native card:

1 Connect the Primary Port to DigiLink Mini Port 1 on the HD Native card using the included DigiLink
Mini cable.

2 Connect the additional HD I/O (or other compatible Pro Tools audio interface) by doing one of the
following:

o Connect the Primary Port of the secondary interface to the Expansion Port of the primary
interface with an additional DigiLink Mini cable (or DigiLink to DigiLink Mini adapter).

— or —

+ Connect the Primary Port of the secondary interface to DigiLink Mini Port 2 on the HD Native
card.

3 Make the necessary Loop Sync connections (see “Connecting Loop Sync” on page 17).
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Connecting Loop Sync

If you are using two or more Pro Tools audio interfaces or a SYNC peripheral, Loop Sync must be
connected to maintain proper clock synchronization among the devices. For examples that include a
SYNC peripheral, see the SYNC HD Guide. For an example of connecting multiple Avid HD audio
interfaces, see Figure 4 below.

To make Loop Sync connections:
1 Connect the Loop Sync Out of each interface to the Loop Sync In of the next interface with a BNC

cable.

2 Connect the Loop Sync Out of the last interface to the Loop Sync In of the primary interface or SYNC
peripheral with a BNC cable.

Figure 4. DigiLink Mini and Loop Sync connections for two HD 1/0Os with HD Native

Chapter 3: Connecting HD /O 17



Connecting HD 1/O to Pro Tools|HD Cards

To connect HD I/O to a Pro Tools|HD card:

= Connect HD I/0 Primary Port to the DigiLink Port on the first available Pro Tools|HD card with a
DigiLink cable (included with your Pro Tools|HD hardware) and a DigiLink Mini adapter.

12-foot DigiLink cable with
DigiLink Mini adapter

Figure 5. HD 1/O connected to the DigiLink Port on a Pro Tools|HD Accel Core card (16-channel I/O system)

To connect multiple HD 1/Os to a Pro Tools|HD system:

1 Connect the Primary Port of the first HD I/0 to the DigiLink Port on the Pro Tools|HD Accel Core
card with a DigiLink cable (included with your Pro Tools|HD system) and a DigiLink Mini adapter.

2 Do one of the following:

o Connect the Primary Port of the second HD I/0 to the Expansion Port on the first HD I/O with the
included 18-inch DigiLink Mini cable.

— or —

« Connect the Primary Port of the second HD I/0 to the next available Pro Tools|HD card with a
DigiLink cable and a DigiLink to DigiLink Mini adapter.

3 Connect additional HD I/Os to additional Pro Tools|HD cards.

4 Make the necessary Loop Sync connections.

18 HD I/O Guide



Connecting Loop Sync

If you are using two or more Pro Tools audio interfaces or a SYNC peripheral, Loop Sync must be
connected to maintain proper clock synchronization among the devices. For an example of connect-
ing multiple Avid HD audio interfaces, see Figure 6 below.

To make Loop Sync connections:

1 Connect the Loop Sync Out of each interface to the Loop Sync In of the next interface with a BNC
cable.

2 Connect the Loop Sync Out of the last interface to the Loop Sync In of the primary interface or SYNC
peripheral with a BNC cable.

Pro Tools|HD Accel card

Figure 6. Making DigiLink and Loop Sync connections with two Pro Tools|HD cards, one HD OMNI,
and three HD 1/Os

Chapter 3: Connecting HD 1/O
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Chapter 4: Configuring HD 1/O in Pro Tools

This chapter explains how to configure
Pro Tools for use with HD I/0.

For more information about configuring
Pro Tools, see the Pro Tools Reference Guide.

Hardware Setup

In the Hardware Setup dialog, Pro Tools lets you
set the default sample rate (if no session is open)
and clock source for your system, and provides
access to arange of controls specific to each type
of audio interface.

Default Sample Rate

The Sample Rate setting appears as the default
sample rate when you create a new session.
(This setting is available in the Hardware Setup
dialog only when no session is open.)

Q You can change the sample rate when
" creating a new Pro Tools session by
selecting a different sample rate in the
New Session dialog.

To change the default Sample Rate for new
sessions:

1 If a Pro Tools session is currently open, close
it.
2 Choose Setup > Hardware.

3 From the Sample Rate pop-up menu, select the
sample rate that you want.

Peripherals
HD 11O #1

HD Core PCle #1

Clock Source:

| Internal 5

Loop Master: HD 1O #1

Sample Rate:

v aa1kiz .
48 kHz

88.2 kHz
96 kHz
176.4 kHz
192 kHz

Selecting the default sample rate

4 Click OK.

Chapter 4: Configuring HD 1/O in Pro Tools
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High Sample Rates and Expanded
Pro Tools|HD Systems

With 176.4 kHz and 192 kHz sample rates, as
many as four Pro Tools|HD cards can be used.
Any additional cards (up to the total system
maximum of seven cards) will switch to Inactive
mode. The Pro Tools|HD cards and any attached
peripherals will become active again when the
sample rate is set to 96 kHz or lower. See the
Pro Tools Expanded Systems Guide for more
information.

Clock Source

The Pro Tools Hardware Setup dialog lets you
set the Clock Source for the system.

Internal If you are recording an analog signal
directly into Pro Tools, you will usually use the
Pro Tools Internal clock source.

External If you are transferring material into
Pro Tools from an external digital device, or if
you utilize a common house clock signal, you
will need to synchronize Pro Tools to that digi-
tal device or common signal. Depending on your
audio interface configuration and the selected
sample rate, external options can include:

« S/PDIF [Encl] (at all sample rates)
« Optical (S/PDIF) [Encl] (up to 96 kHz)
« AES/EBU [Encl] (at all sample rates)

« AES/EBU 1-8 (Single Wire in stereo pairs at
all sample rates)

« AES/EBU 1-4 (Dual Wire) (in stereo pairs at
176.4 and 192 kHz)

+ ADAT 1-8 (at 44.1 and 48 kHz)

o ADAT S/MUX 1-4 (at 88.2 and 96 kHz)

« ADAT S/MUX 1-2 (at 176.4 and 192 kHz)
o TDIF 1-8 (at 44.1 and 48 kHz)

« Optical ADAT [Encl] (at 44.1 and 48 kHz)
« Word Clock (at all sample rates)

HD I/O Guide

To select the Clock Source:

1 Choose Setup > Hardware.

2 From the Clock Source pop-up menu, select
the clock source.

Peripherals
HD 11O #1

HD Core PCle #1

Clock Source:

AES/EBU [Encl] !

AES/EBU 1-2
AES/EBU 3-4
AES/EBU 5-6
AES/EBU 7-8

ADAT 1-8

TDIF 1-8

Optical (ADAT) [Encl]
‘Word Clock (44.1kHz)

Selecting the Clock Source

3 Click OK.

A Your digital input device must be connected
and powered on for Pro Tools to synchronize
to it. If your input device is not powered on,
leave the Clock Source set to Internal.



Identify

If you have multiple audio interfaces of the same
type connected to your system, you should con-
firm the identity of each interface. This ensures
that you select the appropriate interface in the
Peripherals list when defining its inputs and
outputs, and other settings, in the Hardware
Setup dialog.

To identify audio interfaces in your system:

1 Choose Setup > Hardware.

2 From the Peripherals list, select an audio
interface connected to your system.

Use the Up and Down Arrow keys to scroll
though the Peripherals list in the Hardware
Setup dialog.

3 Select the Identify option, located in the lower
left corner of the Hardware Setup dialog. This il-
luminates all the LEDs on the front panel of the
selected audio interface.

4 Make a note of which interface in your studio
setup corresponds to the identified interface.

5 Repeat the above steps for each additional au-
dio interface in your setup.

Configuring HD 1/0

To configure controls for HD 1/O:

1 Choose Setup > Hardware.

2 From the Peripherals list, select the HD I/0
audio interface.

3 Click the Main tab and configure the options.

Handware Secup
| Periphesans
o v woun
>HD VO [l ansioa i g
e Guan Diges Fermsn
1ot [mmogia W [Anse iz # @i
B4 | Ansiog 14 8] [ Amisgia il ) srow
s 3-8 [ Ao 14 R &) (O eseasyros
7-8 [nsop 72 5] Anicqsa e
10 [ A 1 B [ Digin-zearsioan ) Taacam
Vit (Mg @] | e @)
o Di-se (At ss ) os-eaison 1)
e W |
Eat G Dutpat | Werd Gioeh 58 hiss— 18]
ety Ty ]

HD I/O Hardware Setup, Main page

4 If you have at least one HD I/O AD card, click
the Analog In tab and configure the options. If
you have two HD I/0O AD cards, this tab is la-
beled Analog In 1-8.

Permtaraty

| W
| »wown

)

#
1]

sl
=
£
=
=

I

HD I/O Hardware Setup, Analog In page

Chapter 4: Configuring HD 1/O in Pro Tools

23



5 If you have two HD I/0 AD cards, clickthe An-  HD 1/0O Hardware Setup Options

alog In 9-16 tab and configure the options. . )
HD I/0 provides multiple pages of Hardware

e s Setup options depending on the configuration.

i
i
§ |

@ Main Page

HD 1/0 supports up to sixteen channels of

= simultaneous input and output in multiple I/0
= formats (including analog, AES/EBU, ADAT
Optical, S/MUX, S/PDIF, and TDIF).

§|18](8118] iENEE B |

The Main page of the Hardware Setup dialog is
where you define which physical inputs and out-
6 If you have at least one HD 1/0 Digital card, puts on your audio interface are routed to avail-
click the Digital tab (this is labeled Digital 1-8 if able input and output channels in Pro Tools.
you have two HD 1/0 Digital card installed) and You can think of this window as a patchbay that

HD I/O Hardware Setup, Analog In 9-16 page

configure the options. lets you route any of the input pairs or output
pairs on your Pro Tools audio interfaces to
— e St channel assignments in the Pro Tools mixer.
AP e LT
Dugital Foomat Sarvgie Rate Comvriion Hasdware Setup
@ Ay in al-e |
) o =
Py s o
3 i i = e o
o] 12 [Ansiog i-7 W [(Amieg iz E (R
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HD 1/O Hardware Setup, Digital page 52 ) ——

HD 1/O Hardware Setup, Main page (8 x 8 x 8 shown)
Q At session sample rates above 48 kHz, sam-

plerate conversion for the TDIF and Optical
(ADAT) inputs on the HD I/O Digital card is
automatically enabled on all eight inputs of
the selected format unless you are using
S/MUX Optical.

7 If you have two HD I/0 Digital cards installed,
click the Digital 916 tab and configure the
options.

8 When you are finished, click OK.
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Input

Select the corresponding physical inputs from
the Input pop-up menu for each stereo pair of
Pro Tools Input channels (1-2, 3-4, ...15-16).
Which physical inputs are available depends on
the sample rate and on which HD I/0 Expansion
cards you have installed (for example, if no

HD 1I/0 AD card is installed, no analog inputs
will be available).

(Y These settings are saved with the system, not
with the session.

Output

Select the corresponding physical outputs from
the Output pop-up menu for each stereo pair of
Pro Tools Output channels (1-2, 3-4, ...15-16).
Which physical outputs are available depends
on the sample rate and on which HD I/0 Expan-
sion cards you have installed (for example, if no
HD I/0 DA card is installed, no analog outputs
will be available).

Q These settings are saved with the system, not
with the session.

Control-click (Mac) or Start-click
(Windows) to select multiple Inputs or
Outputs. Command-Option-click
(Mac) or Control-Alt-click to cascade
all Input or Output settings.

Inputs and Outputs of Similar Formats

Inputs and outputs of similar formats are differ-
entiated in the input and output channel pop-up
menus. For example, the AES/EBU inputs and
outputs in the HD I/0 enclosure are listed as
AES/EBU [Encl], while the AES/EBU inputs and
outputs on a HD I/0 Digital card are listed (in
pairs) as AES/EBU 1-2, AES/EBU 3-4, AES/EBU
5-6, and AES/EBU 7-8. For HD I/0s equipped
with an second Digital card, the additional
AES/EBU I/0 ports on the optional card are
listed as AES/EBU 9-10, AES/EBU 11-12,
AES/EBU 13-14, and AES/EBU 15-16.

Digital Format

Select from the following digital input formats
for the built-in digital I/O enclosure (configure
the options for any additional HD I/O Digital
cards by clicking the corresponding Digital tab):

AES/EBU Provides up to two channels of
AES/EBU input.

S/PDIF Two channels of S/PDIF (coaxial) input.

Optical (S/PDIF) Two channels of S/PDIF (opti-
cal) input up to 96 kHz. This option is not avail-
able at sample rates higher than 96 kHz.

S/PDIF Format

For S/PDIF (Sony/Phillips Digital Interface For-
mat) compatibility with Tascam DA-30 DAT re-
corders, select the Tascam option under S/PDIF
Format.

Chapter 4: Configuring HD 1/O in Pro Tools

25



Ext. Clock Output

If you want to send clock output to other devices
attached to HD I/0, select the appropriate out-
put from the Ext. Clock Output pop-up menu.

The available options for Ext. Clock Output
change depending on the session sample rate.
See the table below for a list of default external
clock settings and available options.

Ext. Clock Output options by sample rate

Samole Rate Available Ext. | Available Ext.
P Clock Default | Clock Option
44.1 kHz Word Clock N/A
(44.1 kHz)
48 kHz Word Clock N/A
(48 kHz)
88.2 kHz Word Clock Word Clock
(88.2 kHz) (44.1 kHz)
96 kHz Word Clock Word Clock
(96 kHz) (48 kHz)
176.4 kHz Word Clock Word Clock
(176.4 kHz) (44.1 kHz)
192 kHz Word Clock Word Clock
(192 kHz) (48 kHz)

Analog In Page

The Analog In page of the Hardware Setup dia-
log lets you set the Reference Level for the phys-
ical analog inputs on HD I/0. You can also apply
a limiter to each of the available analog inputs.

If you have only a single HD I/O AD Expansion
card installed, a single Analog In tab is available.
If you have two HD I/O AD Expansion cards in-
stalled, the tabs Analog 1-8 and Analog 9-16 are
available. The Analog In, and Analog 1-8 and An-
alog 9-16 pages provide the same controls for
the corresponding physical inputs on the HD I/O
AD card. If no HD I/0O AD Expansion card is in-
stalled, these tabs are not available.
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I

Hardware Setup, Analog In page

Reference Level

Select the appropriate Reference Level for each
of the available analog input channels. This lets
you select the analog audio input source on a
channel-by-channel basis. The +4 dBu option
routes audio from the physical +4 dBu Balanced
DB-25 Analog Input port on the card. The

—10 dBV option routes audio from the physical
-10 dBV Balanced DB-25 Analog Input port on
the card.

+4 dBu and —10 dBV DB-25 Analog Input ports

Limiter

HD 1/0 provides options for soft limiting on
each of the available analog input channels. Se-
lect the desired option from the corresponding
Limiter pop-up menu:

None Applies no limiting to the incoming ana-
log signal.

Soft Clip Attenuates the incoming analog signal,
providing extra protection from temporary clip-
ping transients that can cause digital distortion
when they exceed the maximum input of the



unit. With Soft Clip enabled, HD I/0 supports an
additional 4 dB of headroom by rounding off the
top 4 dB to the clip point. This is useful for elim-
inating stray transients.

Curv Attenuates the incoming analog signal us-
ing a soft knee limiter circuit. This guarantees
super soft limiting without becoming hard, even
with large overloads on input.

Digital Page

The Digital page of the Hardware Setup dialog
lets you set the Input Format and Sample Rate
Conversion for any Digital I/0 cards installed in
HD I/0.

If you have only a single Digital I/0 card in-
stalled, a single Digital tab is available. If you
have two HD 1/0 Digital Expansion cards in-
stalled, the tabs Digital 1-8 and Digital 9-16 are
available. The Digital (one Digital card), or the
Digital 1-8 and Digital 9—16 (two Digital cards)
pages all provide the same controls for the cor-
responding physical inputs on the HD 1/0 Digi-
tal card. If no HD 1/0 Digital Expansion card is
installed, these tabs are not available.

LT T )
Sarrgin Rate Eomariion
al-e
ADAT 13 i
Clensa
ok Sourre 7

[ e T et

HD I/O Hardware Setup, Digital page

Q At session sample rates above 48 kHz, sam-
"~ plerate conversion for the TDIF and Optical
(ADAT) inputs on the HD 1/0 Digital card is
automatically enabled on all eight inputs of
the selected format—unless you are using
Optical (ADAT S/MUX).

Digital Format

Select from the following digital formats for the
HD 1/0 Digital card. Depending on the sample
rate, different Digital Format options are avail-
able.

Peripherals
HO OMNI 1 Interface HB IO
= HD IO #1

Main  Anslog in - Cigital-|
AMD MADI Cigiink 1 =

Eigital Farmat Sasngle Rate Conversion
&) ARS/ORL 1-R
() ADAT 1-8

Oeni-z
i eha-4
I chs-6
Ccn7-g

HD Core PCle #1, g ) Tour 3-8

Clack Souree:
interna )
Loop Master: HD OMNI #1

Sample Rate:

AL 2]

HD I/0 Hardware Setup, Digital Format options at
44.1 kHz

Peripherals

HD OMNI §1 Intertace HO LD
= HD IO #1
Main  Amalog in - Digital |
AMD MADI DigLink 1 =
Bigital Farmat Sample Rate Comversion
prene Ona-z
) AES/EBL 1-8 Ol eh a4
H Care PCle #1, Bp ADAT Censes
Clock Source: &bt Cicn7-g
-4
{interna H el
Loap Master; HD OMNI 41 L
) 1-8 (5RE)

Sample Rate
96 kHz il

HD I/O Hardware Setup, Digital Format options at
96 kHz

Peripherals
HO OMNI 1 Interface HB IO
= HD IO #1

Main  Anslog in - Cigital-|
AMD MADI Cigiink 1 =

Eigital Farmat Sasngle Rate Conversion
Oeni-z
i eha-4
Clchs-6
Ccn7-g

AES TR
) 1-8 Single Wire)

HD Core PCIe 1, Eap 14 [Dual Wiee)

Clack Source: oy

{interna H Sithds

Loop Master: HD OMKI 81 D 1-2 Gfweg
Tow

Sample Rate:

) 1-8 (8RC)
192 kitz il
—

HD I/O Hardware Setup, Digital Format options at
192 kHz
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AES/EBU

You can select up to eight channels of AES/EBU
input depending on the sample rate. At sample
rates of 44.1 kHz to 96 kHz, the only option
available is AES/EBU 1-8 (or AES/EBU 9-16 for
the second card, if present). At sample rates of
176.4 kHz and 192 kHz, two AES/EBU options
are available (Single Wire and Dual Wire
modes).

AES/EBU 1-8 Enable this option for eight chan-
nels of AES/EBU input. This is the only option
available at sample rates of 44.1 kHz to 96 kHz.
This option is not available at higher sample
rates.

AES/EBU 1-8 (Single Wire) Enable this option
for eight channels of AES/EBU input. Sample
Rate Conversion is available for stereo pairs
when Single Wire mode is selected. This option
only appears at sample rates of 176.4 kHz and
192 kHz.

AES/EBU 1-4 (Dual Wire) Enable this option for
four channels of AES/EBU input at sample rates
of 176.4 kHz and 192 kHz. Sample Rate Conver-
sion is not available in Dual Wire mode. This op-
tion only appears at sample rates of 176.4 kHz
and 192 kHz.

ADAT

You can select up to eight channels of ADAT in-
put depending on the sample rate. At 44.1 kHz
and 48 kHz, the only option available is ADAT
1-8 (or ADAT 9-16 for the second card, if pres-
ent). At sample rates of 88.2 kHz and higher,
two ADAT options are available (SRC and
S/MUX).

ADAT 1-8 Enable this option for eight channels
of ADAT input. This is the only option available
at sample rates of 44.1 kHz and 48 kHz. This op-
tion is not available at higher sample rates.
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1-8 (SRC) Enable this option for eight channels
of ADAT input with automatic Sample Rate
Conversion (SRC). This option only appears at
sample rates of 88.2 kHz and higher. This option
is not available at 44.1 kHz and 48 kHz.

1-4 (S/IMUX) Enable this option for four chan-
nels of ADAT input with S/MUX (sample multi-
plexing). This option only appears at sample
rates of 88.2 kHz and 96 kHz.

1-2 (SIMUX) Enable this option for two channels
of ADAT input with S/MUX (sample multiplex-
ing). This option only appears at sample rates of
176.4 kHz and 192 kHz.

TDIF

Depending on the sample rate, you can select
eight channels of TDIF (Tascam Digital Input
Format) input—TDIF 1-8, or TDIF 9-16 for the
second card, if present—with or without auto-
matic Sample Rate Conversion (SRC).

TDIF 1-8 Enable this option for eight channels of
TDIF input. This option is only available at sam-
ple rates of 44.1 kHz and 48 kHz.

1-8 (SRC) Enable this option for eight channels
of TDIF input with automatic Sample Rate Con-
version. This option is only available at sample
rates of 88.2 kHz and higher.



Sample Rate Conversion

Sample Rate Conversion (SRC) is independently
available for AES/EBU stereo input pairs at all
sample rates. When Digital Formatis set to ADAT
or TDIF, SRC can only be enabled or disabled for
all channel inputs. Sample Rate Conversion on
Input is only available for Digital I/O cards, it is
not available for the enclosed digital ports.

A\ Digital outputs do not support sample rate
conversion.

A Sample Rate Conversion adds latency to the
input signal, so you should usually disable
Sample Rate Conversion when it is not
needed.

Q At session sample rates above 48 kHz,
sample rate conversion for the TDIF and
Optical (ADAT) inputs on the Digital I/0
card is automatically enabled on all eight
inputs of the selected format—unless you
are using Optical (ADAT S/MUX).

AES/EBU

When Digital Format is set to AES/EBU, SRC can
be enabled or disabled for each stereo input
pairs at sample rates of 44.1 kHz to 96 kHz, and
at 176.4 kHz and 192 kHz in Single Wire mode.
Sample Rate Conversion is not available for
AES/EBU at 176.4 kHz and 192 kHz in Dual
Wire mode.

Peripherals
HD OMNI #1
*HO IO #
AMD MADI DigiLink 1

Interlace HE 1[0
Main  Asslog in | Oightal |
Digital Format Saenle Rate Conwersion
AES TR Meoni-z
) AES/EBL 1-8
HO Core PCIe #1, Exp ADAT

™ chi-a
] O chs-6
Clock Source = ch7-8
_Internas 2]

Loop Master: HD OMKI #1 L
1-815R0)

Sample Rate:

L9 kHa 2]

SRC enabled for AES/EBU Input channels 1-2 and
3-4 at a Sample Rate of 96 kHz

ADAT

For sample rates of 44.1 kHz and 48 kHz, when
Digital Format is set to ADAT, Sample Rate Con-
version can be enabled or disabled for all inputs.

ADAT (SRC)

At sample rates higher than 48 kHz, with ADAT
(SRC) selected as the Digital Format, Sample Rate
Conversion is enabled automatically for all
input channels.

ADAT (S/MUX)

At sample rate higher than 48 kHz, with ADAT
(S/MUX) selected as the Digital Format, Sample
Rate Conversion can be enabled or disabled for
all input channels.

TDIF

For sample rates of 44.1 kHz and 48 kHz, when
Digital Format is set to TDIF, Sample Rate Con-
version can be enabled or disabled for all inputs.

TDIF (SRC)

At sample rates higher than 48 kHz, with TDIF
(SRC) selected as the Digital Format, Sample Rate
Conversion is enabled automatically for all
input channels.

Set To Default

The Set To Default button sets all settings to the
factory defaults, except for the Digital Format
setting in the Main page.
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Using Input Trims

Input Trims

Input Trims

The Input Trims below the two DB-25 connec-
tors on the HD I/O AD Expansion card are used
to store a calibration settings for each channel.
These adjustable Input Trims are for precisely
calibrating the adjustable headroom settings for
each channel. You can adjust each Input Trim by
hand with a small screwdriver.

About Input Operating Levels

Check the manufacturer’s documentation for
your mixer, power amplifier, or effects proces-
sor to see if it operates more comfortably at line
level, in which case consider setting the HD I/0
to operate at —10 dBV line levels and adjusting
the Input Trims.

30 HD /O Guide

Consider the following when connecting a
mixer:

o If your mixer cannot handle more than 1.5V
(RMS) inputs at +4 dBu, then you should set the
HD I/0 to operate at -10 dBV line level.

o If your mixer can handle up to 15.5V (RMS)
inputs, or has pads or attenuators on its inputs,
then you can use the +4 dBu setting on the

HD I/0.

« HD I/0O is calibrated at the factory for 18 dB
headroom at the +4 dBu setting.

Most manuals contain device input specifica-
tions, including whether or not there are pads or
attenuators. Refer to the manufacturer’s docu-
mentation for your mixer or power amplifier for
more information.

Oy If you want to switch the input levels of the
" HDI/O from +4 dBu to =10 dBV, you can
access these parameters on a channel-by-
channel basis in the Hardware Setup dialog
(see “Hardware Setup” on page 21).



Chapter 5: Adding or Removing 1/0 Cards

The HD I/0 has four Expansion I/O bays on the
back of the unit. Depending on which version of
HD 1/0 you purchased, one, two, or none of
these bays may be empty and available for addi-
tional I/0 cards:

o 8x8x8:threebays are used and the fourth
bay is empty.
« 16 x 16 Analog: all four bays are used.

« 16 x 16 Digital: two bays are used and two
are empty.

The Expansion I/0 bays let you configure HD
I/0 with any of the following Expansion I/0
cards (each sold separately) to increase the
amount of available I/O on the unit:

« HD I/0 AD Expansion card
« HD I/0 DA Expansion card
« HD I/0 Digital Expansion card

A\ 1tisimportant that you follow the guidelines
in this chapter to avoid damaging your
HD 1/0 or any of your 1/0 Expansion cards.

The factory-installed cards can be removed, if
needed, for servicing, or to swap out cards for
different studio setups. If you remove any of the
cards from the HD I/0, the unit will continue to
function as long as at least one card is installed
(albeit with reduced I/0 capabilities).

A\ Legacy 192 1/0 AD, DA, and Digital Option
cards are not supported with HD 1/0. Any
attempt to install legacy 192 1/0 cards will
void the warranty for your HD 1/0.

Removing an 1/0 Card

To remove an Expansion I/O card:

1 Power off and disconnect the HD I/O from
your system.

2 Make sure that the equipment is properly
grounded.

A Before handling any of the cards or internal
components of HD I/0, discharge any static
electricity by touching the outer casing of
the power supply.

3 Remove all of the small Phillips-head screws
around the edges of the top cover. Put the screws
in a safe place.

Removing the top cover screws

4 Lift off the top panel of the HD I/0 and set it
aside.

Chapter 5: Adding or Removing I/O Cards
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5 Remove the screws on the back panel for the
I/0 card you want to remove.

Removing the screws securing an I/O card

6 Holding the 50-pin cable which connects the
card to the HD I/0O chassis firmly, gently pull the
cable connector from the card’s connector.

p '- ﬂ_h‘ﬂ-'lfi - .
Removing the 50-pin cable connector from an 1/O card

7 Gently remove the card, pulling it straight out
from the chassis.

& 1T ATIT 41

Removing an I/O card from the HD I/O chassis

HD I/O Guide

A When you pull a card out, pay particular at-
tention to keeping components on the sur-
faces of the card from bumping into any of
the internal components or the back panel
faceplate on the HD 1/0.

8 Place the card in a static-free bag and keep it in
a safe place (if you are not sending it to Avid for
service).

9 Firmly grasp the 50-pin cable connector to the
HD I/0 chassis and gently pull to remove it (be
sure to keep the cable in a safe place).

10 If you have a cover for the empty expansion
bay, secure the cover over the empty bay with the
screws you removed from the I/0 card.

11 Replace the top cover on the HD I/0.

12 Replace the original screws.

Hardware Setup Changes After
Removing a Card

In this case, the Hardware Setup dialog will re-
flect the change to the installed I/O cards. The
remaining inputs and outputs will function nor-
mally.

For example, if you remove the Analog Input
card, the Analog Input tab will disappear from
the Hardware Setup dialog.

You will lose the configuration of any pairs of
inputs or outputs that were assigned to the card
being removed.



Installing an Expansion /O
Card

To install an Expansion I/O card:
1 Power off and disconnect the HD I/0 from
your Pro Tools|HD system.

2 Make sure that the equipment is properly
grounded.

3 Remove all of the small Phillips-head screws
around the edges of the top cover. Put the screws
in a safe place.

4 Lift off the top of the HD I/O and set it aside.

5 If necessary, do one of the following:

« Remove the screws on the cover over the
empty bay where you want to install an Ex-
pansion card.

« Remove the currently installed I/O card

that you want to replace (see “Removing an
I/0 Card” on page 31).

6 Look into the empty bay to locate the guide
rails for the card to slide in on.

Guide rails along sides of empty bay

7 Remove the Expansion I/0 card that you want
to install from its static-free bag.

A Before handling any of the cards or internal
components of HD I/0, discharge any static
electricity by touching the outer casing of
the power supply.

8 Slide the edges of the card into the guide rails
on each side of the bay.

| ,"a.'.

Inserting the card into the guide rails for the empty bay

9 Gently push the card back into the bay, lifting
slightly to keep components underneath the card
from touching the back panel.

Lifting slightly while pushing the card back into the bay
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10 Secure the I/0 card to the back panel of the
HD 1/0 chassis with the same screws you re-
moved from the either the empty bay cover or
from the I/0 card you previously removed.

Securing the 1/O card to the back panel of the HD 1/O

11 Locate the raised ridge in the middle of the
connector on one end of the 50-pin cable that
connects the I/0 card to the HD I/0 chassis. This
ridge is only on one side of the connector, and
there is a matching groove on only one side of
the 50-pin connector on the chassis.

12 Gently push the cable connector into the
chassis’ connector. The ridge on the cable con-
nector must line directly into the groove on the
chassis connector. Be very careful not to bend

any of the pins.

Connecting the 50-pin cable to the HD I/O chassis

HD I/O Guide

13 Locate the raised ridge in the middle of the

connector on the other end of the 50-pin cable

that connects the I/O card to the HD I/0 chassis.
This ridge is only on one side of the connector,
and there is a matching groove on only one side
of the 50-pin connector on the card.

14 Gently push the cable connector into the
card’s connector. The ridge on the cable connec-
tor must line directly into the groove on the card

connector. Be very careful not to bend any of the
pins or to over-stress the card.

=

Pressing the 50-pin cable onnector ino the car
15 Replace the top cover on the HD I/0.

16 Replace the original screws.

17 Reconnect the HD I/0 to your system.

18 Power on the HD I/0.

19 When you power on the unit, verify that the
LED ring around the power switch lights orange.

20 Start up the computer.

21 When you start the computer, verify that the
power ring turns from orange to green. (If this
does not occur, see “Troubleshooting” on

page 35.)

22 Launch Pro Tools.



23 Open the Hardware Setup dialog to confirm
that the new card is recognized:

« If you installed a Digital Expansion card,
you should see a new tab called “Digital
9-16."

« If you installed an AD Expansion card, you
should see a new tab called “Analog In
9-16.”

24 If the new card does not appear in the Hard-
ware Setup dialog, power down, check the seat-
ing of the card, and recheck the cable
connections inside the HD I/0.

Hardware Setup Changes After Adding
a Card

Any additional inputs and outputs provided by
the new card will appear in the Hardware Setup
dialog, with the same controls and parameters
as for the original card of the same type.

For example, if you add an Analog Input card to
the original three cards, a second Analog Input
tab will appear in the Hardware Setup dialog.
You can route these new inputs (which will in
this case be called Analog Inputs 9-16) with the
same controls and parameters as the factory-in-
stalled version of the card.

Q Whenever a card is added or removed from a
° HD1/0, the routing in the Hardware Setup
dialog reverts to the default assignments. If
you have complex routing and or mirroring
in place, note the assignments and reassign
the inputs and outputs after the new card
has been properly identified.

Troubleshooting

If the power ring does not turn from orange to
green when you boot the computer, check the
following:

« Make sure the DigiLink Mini cable is con-
nected to the Primary port on the back of
the unit.

o Make sure that the 50-pin cables used to
connect the installed I/0 cards to the chas-
sis are firmly connected.

Chapter 5: Adding or Removing I/O Cards
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Chapter 6: Pinout Diagrams for the DB-25
Connectors

Analog Output DB-25 Analog Input (+4 dBu) DB-25

CHl_WoT [ 24 CH1_HoT |24
1 |ceicopf22 1 | cwi_cowo |12
CH1_GND i; CH1_GND i;
CHZ_HOT CHZ_HOT
2 cH2_coLp |23 2 cH2_colp |23
cH2_oNp |11 cH2_oNp |11
cr3_vot |-2L ch3_vot |21
3 cH3_cotp |2 3 | cu3_cowp |2
CH3_GND |22 CH3_GND |22
7 7
CHA_HOT CHA_HOT
4 | cha_cop ;0 4 | cHa_cop |20
8
CHA_GND CHA_GND
CH5_roT |18 CH5_roT |18
5 cHs_colp |8 5 cHs_coLp |6
CH5_GND |19 cH5_GND |19
CH6_HoT |4 CH6_HoT |-+
6 | cHé_colp ;7 6 | cHe_cop 17
CH6_GND CH6_GND |2
CH7_HoT |12 CH7_HoT |12
7 cH7_coLp |3 7 CH7_coLp |3
CH7_GND |16 cH7_GND |16
1 1
CHB_HOT CHB_HOT
8 | cHs_cop |14 8 | cHs_cowp |14
CHB_GND |2 CHB_GND |2
NC_1 ;34- NC_1 L.
wH1 |26 mH1 |26
MH2 |27 wH2 |27
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Analog Input (-10dBV) DB-25

CcH1_HoT |24
cH1_coLp |12
CH1_GND |25
cz_not |10
cH2_cowp | 23
cH2_GND |-LL
cn3_not 2L
cH3_cowp |2
CH3_GND |22
CHa_HoT |-L
cHa_coLp | 20
CH4_GND |-
CH5_HoT |18
cH5_colp |8
CH5_GND |12
CH6_HOT |-+
cH6_coLp |17
CH6_GND |2
CH7_HoT |13
CH7_colp |3
CH7_GND | 16
CHB_HoT L
cH8_coLp |14
CHB_GND |2
N TB
mH1 |26
mH2 |27

38 HD I/O Guide

AES/EBU DB-25

CH12_RCV_HOT
CH12_RCV_COLD
CH12_RCV_GND

24
12
25

CH34_RCV_HOT
CH34_RCV_COLD
CH34_RCV_GND

10

23

11

CH56_RCV_HOT
CH56_RCV_COLD
CH56_RCV_GND

21

22

CH78_RCV_HOT
CH78_RCV_COLD
CH78_RCV_GND

20

CH12_XMT_HOT
CH12_XMT_COLD
CH12_XMT_GND

18

19

CH34_XMT_HOT
CH34_XMT_COLD
CH34_XMT_GND

17

XMT

CH56_XMT_HOT
CH56_XMT_COLD
CH56_XMT_GND

15

16

7-8
XMT

CH78_XMT_HOT
CH78_XMT_COLD
CH78_XMT_GND

14

NC_1
MH1
MH2

13
26

27




TDIF DB-25

CHIZ_RCV_DATA |13
< 1-2 GNDL |23
= 3-4 CH34_RCV_DATA |12
g B GND2 |24
5_6 CH56_RCV_DATA |11
3 - Gnp3 [23
x 7-8 CH78_RCV_DATA |10
B GND4 iz
CH12_XMT_DATA
< 1-2 GNDS ;4
= CH34_XMT_DATA
g 3-4 GND6 ;5
CH56_XMT_DATA
= 5-6 N7 | 16
X 7-8 CH78_XMT_DATA |4
B GND8 |17
RCV_LRCK |2
RCV RCV_EMPHASIS L- NC=
CLK+CTRL Rov_FsL |8 mnc=
RCV_FsO 29 mNnc=
XMT_LRCK |2
XMT XMT_EMPHASTS | 18
CLK+CTRL xr_ps1 | 19 |
XMT_Fs0 |-©
GND9 |7
mH1 |26
mH2 |27

DB25F_RA_TDIF

GND_C

FB30 FB31
T T
22PF 22pPF

GND_C  Gyp_a  GND_C gnp_a
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Chapter 7: HD 1/0O Calibration Mode

Instructions

Before you use HD 1/0, you may want to cali-
brate its input and output levels to the level of
your mixing console.

The HD I/0 has +4 dBu and -10 dBV inputs, and
+4 dBu outputs, each with its own trim pot for
proper calibration.

The HD 1/0 is factory-calibrated so that its

+4 dBu input operating level is set for 18 dB
headroom above +4 dBu (maximum input/out-
put +22 dBu).

If you need to recalibrate your HD I/0 or other
components of your studio, you can use the
alignment procedure described in this chapter.

About Calibration

Calibrating levels on a digital recording device
is different from calibrating levels on an analog
recording device. Unlike analog devices, most
digital devices do not have a standard “0 VU”
level setting that corresponds to nominal input
and output levels. Instead, with an interface
such as the HD I/0, the meters are calibrated in
decibels below peak or dBFS (dB full scale)—dig-
ital clipping level.

Headroom

The concept of headroom is slightly different for
analog and digital devices.

Analog Most analog devices allow for a certain
amount of headroom above 0 VU. If you send a
signal above 0 VU to an analog recorder, you
still have a margin of headroom, and if tape sat-
uration occurs, it does so fairly gracefully, giv-
ing the audio a compressed sound that some
find desirable.

Digital Digital devices do not allow for signals
that exceed the dynamic range of the input or
dBFS (dB full scale). When a signal exceeds the
maximum input level for a digital device, clip-
ping occurs, causing digital distortion, which is
harsh and usually undesirable.

The Calibration Process

Analog To calibrate the input level of an analog
device to a mixing console’s output level, you
would typically send a 1 kHz tone at 0 VU from
the console to the analog deck and align the re-
cording deck’s meters to read 0 VU.

Digital With a digital recording device such as
the HD 1/0, in order to allow for headroom, you
must align a 0 VU tone from the console to a
value less than zero (or below dB full scale

[-x dBFS]) on the HD 1/0, by exactly the
amount of headroom that you want.

Chapter 7: HD I/O Calibration Mode Instructions
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For example, to have 12 dB of headroom above
0 VU with the HD I/0, you must align the in-
coming 0 VU 1kHz tone to a level of -12 dBFS.
For 18 dB of headroom, you would align it to
-18 dBFS. (Since it is assumed that you are us-
ing the HD 1/0 with a +4 dBu device or console,
a 0 VU signal level coming out of the device or
console is actually equivalent to a nominal

+4 dBu level signal.)

Calibrating the HD 1/O

To calibrate your HD I/0, use one of the HD I/O
calibration sessions included with Pro Tools
(located in the Pro Tools Utilities/Calibration
Mode Session/HD IO Calibration Session
folder). You can use these sessions as is and
change the input and output assignments for
more HD I/0 channels or use it as a template to
make your own calibration session.

The following instructions show how to create a
calibration session from scratch.

Q If your system includes one or more EUCON
© controllers, be sure to disable “Auto-bank to
selected track” in EuControl software before
enabling Pro Tools Calibration Mode to en-
sure that faders remain silent. To make sure
“Auto-bank to select track” is not enabled,
open the EuControl Settings window, click
to go to the General tab, and verify the set-
ting is not enabled. If necessary, click to dis-
able “Auto-bank to selected track.” After ex-
iting Calibration Mode, be sure to re-enable
the “Auto-bank to selected track” setting (if
necessary).

A\ Turn down your monitoring system before
beginning calibration. The Signal Genera-
tor plug-in emits a continuous signal when
inserted on a track.

HD I/O Guide

To create a session for calibrating your HD I/O:

1 Launch Pro Tools and create a new session.

2 Choose Setup > Preferences and click the Op-
eration tab.

3 Enter the desired Calibration Reference Level
value in dB. A level of -18 dB is typical. (It is not
necessary to type a minus sign here.)

4 Click OK.

5 Create a new mono audio track by choosing
Track > New.

6 Insert the Signal Generator plug-in on the
track.

7 Set the Signal Generator plug-in output level.
This should be the same value you entered as the
Calibration Reference Level (such as -18 dB).

8 Set the Signal Generator frequency to 1000 Hz.
1000 Hz is typical, but any frequency will work.
Other typical values are 250 Hz and 500 Hz.

9 Set the Signal Generator signal waveform to
Sine.

10 Route the track’s output to Bus 1. In the cali-
bration template, Bus 1 has been renamed to “1k
Tone”

11 Create a mono Auxiliary Input track for each
HD 1/0 output you want to calibrate. Set the out-
put assignment for each of these Auxiliary In-
puts to its respective I/O output.

12 Set the input of each Auxiliary Input track to
Bus 1, or 1k Tone for the template session.



13 Create an additional mono Auxiliary Input
track for each input you want to calibrate. Set
the input assignment for each of these Auxiliary
Inputs to its respective I/O input. Then set the
output of each of these Auxiliary Inputs to an
unused bus pair (for example Bus 3-4). In the
template session the bus names are Null and Out.
This makes sure feedback doesn’t occur when
monitoring main outputs 1-2.

14 Connect an external VU meter to each of the
I/0 outputs in turn. (One at a time as you cali-
brate.)

15 Set all Pro Tools track faders to their default
of 0 dB by Option-clicking (Mac) or Alt-clicking
(Windows) any fader.

16 Adjust the I/0 output level trim pot with a
small, flat-head screwdriver to align the outputs
to read “0 VU” on the external VU meter. We
recommend using a tweaker tool with a recessed
flat-head surrounded by a plastic tube to hold
the trim pot. Tweakers can usually be found at
electronic supply stores.

To calibrate the HD I/O inputs:

1 Connect the HD I/0 outputs to a bank of
HD 1/0 inputs by doing either of the following:

o Use a DB-25 to DB-25 straight through ca-
ble.

« Interconnect the XLR ends of DB-25-to-
XLR together.

2 In Pro Tools, select Options > Calibration Mode.

The names of all uncalibrated tracks begin to
flash. In addition, the track volume indicator of
each Auxiliary Input track receiving an external
input signal now displays the reference level
coming from the calibrated output (default is
-18 dB).

3 Adjust the HD I/0 input level trim pots with
the same small flat-head screwdriver or tweaker.
It is best to calibrate the inputs with the back of
the HD I/0 facing you and the Pro Tools screen
well in sight. If you cannot see the Pro Tools
screen, consider asking another person to assist
you with the input calibration. When the level is
properly matched, the track name will stop
flashing and the peak volume indicator will indi-
cate your headroom value (the default is
“_18.0”).

The Automatch indicator arrows on each track
show the direction of adjustment required for
alignment:

o When the incoming level is higher than the
reference level, the down arrow will appear
lit (blue). In this case, trim the I/0 input
level down.

« When the incoming level is lower than the
reference level the up arrow will appear lit
(red). In this case, trim the I/O input level

up.

When you have properly aligned the incoming
peak signal levels to match the calibration refer-
ence level, both Automatch indicator arrows
will light: the up arrow red and the down arrow
blue.

Above the fader is a peak volume indicator. This
indicator will show the dB level above and below
your chosen headroom value. If the peak indica-
tor is showing -19.1, you are -1.1 dB below a
headroom value of -18 dB. If the display is
showing -16.5, you are +1.5 dB above your
headroom value of -18 dB.

4 When you have finished, deselect Options >
Calibration Mode.
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Switching Jumpers on the
Analog Output Card

Each Analog Output card for HD I/0 provides a
jumper for each of the eight channels of output
on the card to switch between a Hi and Lo output
setting. The default setting for each jumper is
Hi. This is what you want for working with pro-
fessional gear that operates at +4 dBu levels.

However, if you are working with -10 dBV gear,
you can switch the jumper on Analog Output
card (on a channel-by-channel basis) from the
default Hi position to Lo for a -6 dB pad. You
can then adjust the Trim pot for the correspond-
ing output channels by an additional -4 dB to
accommodate -10 dBV gear.

44 HD I/O Guide

To switch the jumpers for output channels on an
Output card:

1 Remove the Output card from the HD I/0O chas-
sis (as described in Chapter 5, “Adding or Re-
moving I/0 Cards”).

2 Place the card on a stable, static free surface.

3 Using tweezers or a pair of needle nose pliers,
gently remove the jumper for each output chan-
nel that you want to modify.

4 Gently, but firmly, replace the jumper in the
position that you want for Hi or Lo output:

« Place the jumper so that it connects the
middle pin and the back pin (furthest from
the DB-25 connector) for the Hi setting
(this is the factory default setting).

o Place the jumper so that it connects the
middle pin and the front pin (closest to the
DB-25 connector) for the Lo setting (-6 dB
pad).

Lo HI
L BN BN

Pin orientation on Output card

5 Replace the Output card in the HD I/0O chassis
(as described in Chapter 5, “Adding or Removing
I/0 Cards”).
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BMOKRLET,

1IBHOF =T 4 & AV EZ =T 21— A%
Pkt L7t AT OWI NN 2T TEMD 3 %75 Loop Sync ##t 2110 £9 (61 X—
HD /0 (F7zidsA—T 14 - 4% —  TD [Loop Sync Z##id % | B,
Tr—RA) HERLET,
« DigiLink Mini 7 — 7 /L2 ffi>T.26H
DAVA—=T2—ADTIFAIY — -
R—rZ1BHOA VY EZ—T 2 —AD
PR R— b AR L E T,
Qs

2HHDOA VR =T 2 —ADT T4
J—+K— k7% HDX #1— F® DigiLink
Mini R— k2K L X9,
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Loop Sync Zi&#H 9D

2HUEOHDA—T 44 A VR —T 2 —
A E 7213 SYNC [AiHkds 2 9 2 %5 i,
Rz IE L < [ E ¥ % 728 Loop Sync 7z #
B9 BREND D £, HED Avid HD A —
TAF AV R—T 2 —ABERKT B HF
62 X—Y DK 2% THBMLZE 0, SYNC
AT 2HIC DV TIE, ISYNCHD A1 R
#TBRE N,

Loop Sync &z I BICI3 :

1BNCT—7 )V f>THEDA Y A—T 2 —
A®D Loop Sync Qut ZRDA > & —T = —
A D Loop Sync In\#&Hi L £9°,

2BNCT — T W 7Z2fi> TREDA VX —
7 2 —ADLoop SyncOutZ 15 HDA > % —
7 2 — A% 72lE SYNC @D Loop Sync In %
il ET,

3% HD II0 &g s 61



62

2. 2DDOHDXA—K. 1D2DHD OMNI. 5D®DHD I/O £®D DigiLink ##t&DIL—7 -

HD /O A1

FE"HDXH—R

N

P

”

T

=
L



HD 1/0 ZHD Native h— FICIEHET D
HD 1/0 % HD Native i— KABR T BI<I :

« {8 DigiLink Mini % —7 L% f#i > T HD 1/0 ® PRIMARY PORT % HD Native #— K 0
DigiLink Mini Port 1 \#&#i L £ 9

3. HD Native 3— F®D DigiLink Mini Port 1 [C#E# LTz HD I/O

22D HD I/O% HD Native A— RAEf I BICIE :

1 {/& DigiLink Mini - —7 L% {fi > T. PRIMARY PORT % HD Native /1 — K ® DigiLink
Mini Port 1 Nkt L £ 97,
2 FOWTF NN ZIT> TGEMDHD 1/0 (X 72iExf )i Pro Tools A —7 4 - 4 > 2 —
Tr—R) BEHRLET,

« B/ DigiLink Min (& 7z(Z DigiLink % DigiLink Mini 77 X 7 % —IZ) Zffi>T2H5H®D
A v HZ—7 2 —ADPRIMARY PORT Z 1 56 H®D 1 > % —7 = — A EXPANSION PORT
ICHREL X9,

Efa

2BHDA VR =T 21— ADT 5 A< — 3 R— k% HD Native 1 — F D DigiLink Mini
R—h2\EHRLET,

3 %75 Loop Sync #4217V E 9 (64 X—I D [Loop Sync Z##:9 % 1 BH),
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Loop Sync Zi&#idI D

2EMUEOHD A =T 14 « £ V2 —T 2 — A X213 SYNC FIARER 2 H 9 5 ok, BEds
ZIEL S A& %728 Loop Sync Z2#i#t 9 2 0 ENH D X9, SYNCZMMH I 2HIicD
WTIE ISYNCHD A A F J ZZBREEI W, HBDAViIdHDA—T 14 - £ > 2 —
Tz —AERT HHIE. K4z2TBRITZE W,

Loop Sync &z I BIcIS :

1BNCHr —T7 W flioTHDA V2 —T 2 —AD Loop Sync Out ZRDA > X —T £ —AD
Loop Sync In i L £ 9,

2BNCT — 7NV Zfi> THREDA V2 —T 2 —ADLoop Sync Out Z 1 5HD A > % —
7 2 —AFT72IE SYNC D Loop Sync In \#&Hi L £ 97,

4. HD I/Os &HD I/0O D DigiLink ##t& Loop Sync it
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HD 1/0 % Pro Tools|HD h— RICiER TS
HD 1/0 % Pro Tools|HD h— RICiE#H I BICIS :

= DigiLink 77— 7l (Pro Tools|HD > X 7 LI fi)@) & DigiLink Mini 77 % 7' 2 — 7% fli> T,
HD 1/0 @ PRIMARY PORT % Pro Tools|HD 71— F DZEW T\ % 1D DigiLink K— F\
L Ed,

DigiLink Mini ZE b fflF7c
127 «— b®DDigiLink 57—

5. Pro Tools|HD Accel Core 1— R®DDigiLink PortN&# UizHD /O (16 F + Y RILDI/IO Y AT Ls)
EHDHD /0% Pro Tools|HD Y AF LAERIBICIS :

1 DigiLink Mini 77 % 7" Z —IZHL D }1F 7z DigiLink 77— 7L (Pro Tools|HD ¥ X7 LIV &)
* DigiLink Z{i> T 1 5 H D HD I/0 ® PRIMARY PORT % Pro Tools|HD Accel Core 71—
F @ DigiLink R— b\ L £ 97,
2ROV N DEEZITVE T,
« [ 181 > F DigiLink Mini 7 — 7 V& ffi>T, 2BHOHD JODT 54U » K—
Fz215HDHD1/0 D [EXPANSION PORT] ~#E#HilL £9,
EA S
. DigiLink Mini 7 % 7 & —ICH{ b f13 7z DigiLink 7 — 7 (Pro Tools|HD ¥ A5 Lic
{i}}8) * DigiLink Zffi 5> T. 2% H® HD 1/0 ® PRIMARY PORT ZX D% T %
Pro Tools|HD 71— R\ L £9
3B/ HD 1/0 Z3E /1D Pro Tools|HD 71— Rkt L £9°,

4 E3 Loop Sync #EHEZTTVE T,

%3% HD /0O Z&Hd 2



Loop Sync Zi&#idI D

26 EDPro Tools & —T 1 A AV Z—7 £ — A FE 1 IX AW SYNC 2 9 285513,
Wdsz U A & % 728 Loop Sync Z 69 2 0 EWH D £97, HED Avid HD +—
TAF A VE—T 2 —ABEFET HHF. 67 TR E L,

Loop Sync &z I BIcIS :

1BNCHr —T7 W flioTHDA V2 —T 2 —AD Loop Sync Out ZRDA > X —T £ —AD
Loop Sync In &R LET (F A4V —Fz—2),

2BNCT — 7NV Zfi> THREDA V2 —T 2 —ADLoop Sync Out Z 1 5HD A > % —
7 2 —AF72IZ SYNC D Loop Sync In \##Hi L £ 97,

ProTools|HD Accel Core
Hh—F

Pro Tools|HD Accel
Hh—k

6. 2D2DPro Tools|HD A3— K. 1 DDHD OMNI.3DDHD I/O £D DigiLink##E#i & D Loop Syncif:
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$B45Pro ToolsTHD 1/O ZRET D

COBETIE. HDI/OZHEH T 572D
Pro Tools DFREHEEZFAL 9,

Pro Tools T D& & 5 iE I D W T,
IProTools U 7 7 LA« A K1 #C
B TZE W,

IN—=ROITT7ERE
IN—=RUzT7REIZATOAT TR T T4
WEOY TN —rORE (Rvav
MWV TWEWES) AT LD 7y 7 -
V—ADHE. &4 —T 44 -4 X—
Jr—A0Oarbra—)L—RAEETE
£9,

FIFILMDYYTILL— B

[V FILL—K] REICIF. #FilHtvy 3
VEERTBZEEDTIFINVEEOY VT
WL—bIRERENET (BB .Y Y3
VHBWTWVWAIRETIE, TOHEHEERY
TTYTAZa—b LTERENEEA),

Q YT L — b HHH Pro Tools 2w

CvavEERT R EEIC FHEEy
vavl RATaTTEETEI LN
TEZEd,

MRty YavoFIFI OB YT IV — b EE
EIBICE:

1 Pro Toolstz v ¥ 3 YW T W BIEEIE.
FDEyaryeEHLET,

2 [8% &1 (Setup) > \— KD 71 (Hardware)
ZIERL 9,

3MHWYIIWL—K] Ky TT7 v T« AZa—
Mo HROY Y7V L — F 2@ L £ 9,

Peripherals
HD 11O #1

HD Core PCle #1

Clock Source:

| Internal 5

Loop Master: HD 1O #1

Sample Rate:

v aa1kiz .
48 kHz

88.2 kHz
96 kHz
176.4 kHz
192 kHz

FIX I DY YTV — NEEIRT D
4[OKl 27V v o L&Y,

%4 Pro ToolsTHD I/O%%&Ed2 67



&YV IIb— k& Pro Tools|HDHEBEV AT L

Y7L — 1 176.4kHz & 192kHz T
T&% Pro ToolsHD 71— Fid4DXTTY,
Zofioh—F (AT LORKI— FE
7)) B 2747 - E—FICEDET,
Pro Tools|HD 71— F & Z @ 71— FIC i
TN/ YTV L— b 96kHZ LR
KREENZEHUET7 VT4 7WCRDET

(FEL <& Pro Tools k> A7 L A K|
S,

A 52LLEDPro Tools|HD /1 — Rz D
kY AT L2, 96kHz Zi8 3 59 > 7
IWL— b TEHATZHICE, 5DHU
k%0 Pro Tools|HD 71— R\ & e
/O ZH DA E TN b £ A,

oa0vy «J—-A

Pro Tools D/N— K = 7% E (Hardware
Setup) XA 7T TE .Y AT LDIOY Y-
V—2ANHRETEET,

A4 2%=F)b (Internal)Pro Tools T7 F+ 1o
JEEEZEELI—T 2 VT3 3551,
EH . Pro Tools DA V& —F)L- 7y 7 -
V—AZzEHALET,

S8 (Externa) i 7Y Z VKR 5
Pro Tools \T— 2 %(% L&, Fizld—
WRIIZNT X« sy JE5x2liHT 5L
Z &, Pro Tools Z M BHEARIC AT ¥ X 9
F—F a4 F AR —T 2 — ADKERL &
WU YTV L —hcE->T, UFDA
TrarvhbhET,

« SIPDIF [Encll (§XTOH > 7L

L—Hh)
« Optical (S/PDIF) [Encl] (&K 96kHz)

« AES/EBU [Encll (9 XTDY T )L
L—Nh)

68 HD I/OAH1 R

« AES/EBU 1-8 (3 RXTOY V)L —
KDRAFLA - RT7DIVH )T A
Y—)

« AES/EBU 1-4 (Dual Wire) (176.4kHz
C19KkHZICHBWTATF LA « X7 T)

o ADAT 1-8 (44.1kH & 48kHz)

o ADAT S/MUX 1-4(88.2kHz & 96kHz)

o ADAT S/MUX1-2(176.4kHz & 192kHz)

« TDIF 1-8 (44.1kH & 48kHz)

« Optical ADAT Encl](44.1kH & 48kHz)

o Word Clock(TXTOY >V L—1)

o0y « V-RZEEIRTBICIT :

1 [87%E] (Setup) > [/\— D =771 (Hardware)
ZERNL X I,

2[r0Ov%s Yv—2X] (Clock Source) Ry 7
Ty T A a—h5HEY ROy TV —
AZERLET,

Peripherals
HD 11O #1

HD Core PCle #1

Clock Source:

AES/EBU [Encl] !

AES/EBU 1-2
AES/EBU 3-4
AES/EBU 5-6
AES/EBU 7-8

ADAT 1-8

TDIF 1-8

Optical (ADAT) [Encl]
‘Word Clock (44.1kHz)

J0vY - V—RZEREIRT D



3[0KI 27 Vw7 L&,

A\ Pro Tools %7 ¥ Z )UKZRICAIIHE ¥ %
IiE, BEsh RSN TEB O BRNAA-
TIRETH B 0EDDH D X9, NS
ICEFEDA> TWAEWEA, Z7avy s -
V—RAE [NE] icLTBEET,

i )

VAT LANEBOR CHEEOL —T 1 4 -
AVE—=T 2 —AZEH LTV EHEE.
BAVE—T 2 —AZHBHNTZEEMNTE
x9, CThICEK->T, IhN—FY 7 RE]
(Hardware Setup) #4707 TAJI&H
N72wEd B, i) (Perlpherals)
VDAMDNBIELWA Y EZ—T 12— A %ER
TEXT,

VATLDF=F 4 F A=D1 —REHHTSD
I<IE :

1 [ %E] (Setup) > [/\— R = 7] (Hardware)
HEIRLE T,

2 [JE A8 25] (Peripherals) U A kb5,
VAT LCHERENTOE A —T 4 A A
=T 1 —AEERLET,

EFORHIF—=Zf>T IN=Frx7
#E] (Hardware Setup) #4717 D
[XVU 7 = F)V] (Peripherals) U X k%
Ar7u—ILEd,

3IN—FU7@&E] X470 T Dk FIC
&5 [#BIT2] (Identify) * 7> 3 72
RWUET, #RLIEA—T oA - A2 5—
TJx—AD78aY bINKJ)VDOLEDWNTXT
RITUE T,

ABINULTEA VY E—T 2 —ANARIFD
EDA VR —T 2 —ACHIE L TWBH X
ELTLEE WD,

58 A —TFT 4 F AV E—Tz— R L
TERDOTFIEZBEOIELE T,

HD 1/0O Z8RET D

HD /O®Y bO—-IVEHETHICIS :

1 [E2%E] (Setup) > U\—R 7] (Hardware)
ZERLE T,

2 [JE#28] (Peripherals) Y A k¢, HD1/O
=T 4 F AV R=T 2 —AZHERLXT,

3[X4A42] (Main) 7% 27Uy oL, &7
vavERELET (BR),

1oz [ Ansing -7

B4 | dnsing 34

%6 | Ansing -4
7-8 | dnsing 74

Clack Sosrea

HD /O DI\— RO T 7H/E. [XAV] R=I

4HDI/OAD?J FODEEE165H%
La. [7rod 141 (Analog In) 27 %72
Yy oL, ATvarvze#ElLEd, HD
[/OAD A—FMW26H55G. TOXTIE
[(7+rOJ 421-8] LERENKT,

3l

sl
=
£
=
]

\\\\\

|||||

I

..... - Cnmvois e

HD /O D/\— ROz 7ERE. [7F0OT 4 VIR—=IJ

% 4% Pro Tools THD /O Z&ET %
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SHDI/O AD i— FW26H 256, [7F

OJ 4> 9-161 2727 Vv 7 L. REIC
JGCTA T avzERELET,
atdware Setup

| Fowar T et e

v Oum =
e Toslh O Nuske £1, Port 0 B . . 5

- B e )

] e Heme 1

o ==

ol L = 2]

. @ —r =1

(oot )

HD 1/O ®/)\— R T 7EE
R—=Y

607 LE1DDOHDI/OT I H) « J1—
FZzflHLTWw3H5EE. [T/’S’)I/]
(Digita) %27 2DDOHDI/O T ¥ X)L -
A—FBA YA P=ILENTVWEHEE
[2#%)L1-8] (Digital 1-8)) 227 Vw7 L
THWOA T a v zRELET,

. [0 12 9-16]

ety S Te Deluat (]

HD /O D/I\—RD I 7ERE. [TIFI] R—=Y
O 48kHz & # % %%~ 7V L — kT,
SIMUX A 77 4 HIVEFHLTWVWSG
AzkE. HDI/OT I 2« I— R D
TDIF A > 7"y k&4 77+ 71)V (ADAT)
DEDODFTANTDA YTy vDY T T)
— MEBDSEBIICE VIR £,
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72DO0OHDI/OTYZ)I « A—RE[MAHL
TW3 5 &1F. [FY4%ILo-16] (Digital
9-16) 27 %27V Yy LTHWNDA TS 3
VERELET,

gibo75, [OK] Z7 Vv 7 LET,

HD 1/O® [I\—FD T 78EE] OF
Foay

HDI/OD [)N—Ro 7 &RE] 04T 3
k. FOBRICE > TEHORXR=U N
HHET,

RLY e N=Y

HD I/OF. HEDI/O T+ —~<v + (7T
0%, AES/EBU. ADAT &7 5 « h1Jl,
S/MUX. S/PDIF. TDIF) T K16F +
INVDAY Ty e T RSy MR L
TVWET,

N— R 7 #&E (Hardware Setup) %1
7argDAALY (Main) X—Y Tld, 4+ —
7"“4’71‘ AV R—=T 21— AKKDED AN
& Hi717% Pro Tools D A S & i~V —
TAVITENERELET, TOEAT
a2, ProToolsA—F ¢4 « 4V & —
T 1 —AKRKD AT & H 1% Pro Tools D =
FH—DF v IIWVICTIA VT B8 F
RA7ZEZEZNTXNOTLE I,

HD OMNI &HD I/OD“'ET Nz N/IORE] 4414
7OJ®D [HH] R—Y (8 x 8 x 8ZFKR)



A7 (nput)

AT RDRY T Ty T A= a—h5,
Pro Tools DA > 7w b F v 2RIV DHK A
TLUA - X7 (1-2. 3-4. ...15-16) TXf
ST RYEA Ty h e RTEENLET,
EDOYHEA Ty RMERTEE0E. A
AR —=ILENTWASHD I/OHEEL— R &
P TINL—hTE->THEEDET (&
ZE. HDI/OAD h— FWRA VA h—)L &
ncuvnhdnErras - 47y MM
HTEEETA),

\§'zn5®%ﬁﬁ\tv93ytﬁﬁﬁ<\
VAT LICREENET,

i3 (Output)

TIORTY hDORY TT v TAZa—h5,
Pro Tools D7 by b « F ¥ VRI)LD
BAT LA« RY7 (1-2. 3-4. ...15-16)
WKHIRT YT I Ry k « X7 EER
LET, EOYETY M Ty FOMFHTE
EZME A VA P=IVENTWVWSHD /0L
BH—REY YT INVL—HITE>THERED
F3 (Jz&x2iX. HDI/O DA 1— KB AV
A=l ENTViRdnE7ra s 7ok
Ty FIFEHTEETA), TNHEDREIL.
tw g TR EL, VAT LICRES
nEk9,

DAY Ty hRT7 T R Ty L RE
K9 % & xik. Control- 7V v 7 (Mac)
F/zi& Start- 7V v 7 (Windows) LT
AEEV, IRTDA Ty hETZT
ThTY VOBREEHNAT—RT B L
&ld.Command-Option- 7 V v 77 (Mac)
% 721 Control-Alt- 7 1 v 7 (Windows)
LT T,

BUI#—<y bDA YTy hEFIRTY b

RS T+r—~<v FDOAHTIE. AN
EHITDF v RV Ry T T SR
Za—DRTRAENTVET, Iz& 21E.
HDI/O WK D AES/EBUD A > S k&7
v+ 7w & [AES/EBU [Encll 1 &R
EN.HD /O T &)+ J1— KD AES/EBU
DAVTy heT7T 7y ME [AES/EBU
1-21. [AES/EBU 3-4]. [AES/EBU 5-61.
[AES/EBU 7-8] &£X7THRREINET,
2DODFT VR H—REFDOHD /0 Tl
B AES/EBU 1/0 K — b (& [AES/EBU
9-101 . [AES/EBU 11-121 . [AES/EBU
13-14]. [AES/EBU 15-16] £ F£RENET,

FIII s TF=Iv b

W T 2210 2T 2 & i, LR
DTFIZ)V AT b TH—<Xv b2
BIRL TLZEW GEMOHD 1/0 Digital
H—ROF T a3, ZhEnoh—Fic
WSS 5 [FYFIV] ZT=7U w7 LTHR
ELTLREN),

AES/EBU. & K2 F ¥ > & )LD AES/EBU
A7 b,

S/IPDIF2 F+ > )LD S/PDIE ([Flfif) >
70‘7 ]\o

Optical(S/PDIF)2 F + > %)L ® S/PDIF
([F#h) 4> 7w . &K96kHz, T DX
vavid 96kHz KO EWY IV L— T
BBRINTEE A,

S/IPDIF7#—= v b

Tascam DA-30 DAT L a— & — L H#%D
% % S/PDIF (Sony/Phillips Digital
Interface Format) Ti&. [S/PDIF 7 % —
<wv b OFOD [Tascam] 4 7> a 7k
RLUTL T,

%4% Pro ToolsTHD I/O%#&Ed2 71



SNaBo 0y oA (Ext. Clock Output)

HD 1/0 I #efi L 7e DR~ T 1w 7 723X
%X, M8 o0y o HEH] (Ext. Clock
Output) R 77w T A= a—h 5y &
72 ERLTL T,

BEmoOyy PORTIv Rl OF T g ik
twiarvoyry IV —hckoTED
DEFT, UFORICT 7V EDHE Y
0w 7 DFRGE L EIRARER A 7Y g ViR
Li@_o

YU T~ hSEDHABHTY S - 79 Ty D
F7vav

EHATES EHATES
I IbL—b | SAEBoOv o saoav o
DFITFIL F7vay
44.1kHz J—RoOwo | 5L
(44.1kHz)
48kHz D—ko0Ovo | BUL
(48kHz)
88.2kHz J—RoOwvo | O—R
(88.2kHz) 0wy
(44.1kHz)
96kHz J—ko0Ovo | D—R
(96kHz) 0wy
(48kHz)
176.4kHz J—RoOwo | O—R
(176.4kHz) 0wy
(44.1kHz)
192kHz J—RoOwvo | O—R
(192kHz) 0wy
48kHz

72 HD I/OAA R

(7300 1] "=V
IN=FoxT7RE] X470 r/D [7FnA
J A4v] X=YTid. HD I/O DYEE 7 F
ny A7y bHOYT 7 LA - LA
IVIRETEET, £le, 7 ur -1
Ty NG Iy A—ZEATEELT,

HD I/O D ADEEA— K1 DT AV A
F—=ILENTW B, (705 14V]
ZTM1IDOERRENET2DDHDI/O AD
JEEEAI— RHA VA P —=ILENTWVB5E.
(7705 1-8] #7 L [770O5 9-16] X7
WERENET, [PFrOdav] 27, [7
>0 1-8] 27, [7+0OF 9-16] X 71Tl
HDI/OAD i— FARKkDZENFNhD AV
Ty MR LUTHELCaY ha—)LHERE
NEIT.HD /O ADERA— RN A VA b—
WENTVEWEEIZ. TheDXZTidE
IRENEL Ao

10y

10y

I




UI7LVALANI

fEHARERS T a s « ATy ke Fr
TN U TRV T 7 YR DRV 38
WLET, ChITE-> T, Frorxibl ki
Tragedr—F 0% ATy V=R
MBRINTEE I, [+4dBul 7 3 vid.
H— RA&MKD +4dBu /N5 > ZFIDB-25 7 F
a7« ATy bk e R=—bbhotr—FaF
EV—T7 47 LET, [-10dBV] &7
va Vi, i— RARAKD -10dBV /N T > AR
DB-257F 0% « AT vk« R—khb
F—F o X E®N—T 0T LET,

+4dBu & -10dBV®DDB-25773 05 - A2V b -
w—b

U=y #H— (Limiter)

HDI/OD4DDET7Fay « £y k- -
Frraxwicid, VIvra 70t
varvhibvEIT, TNFND [UZvy—]
Ky TT7 YT A= a—hh 6 HHNDOL T g
VEERLTLEE,

BL AN ENTE7Y FuldEesy Iy 22—
FEHENEE A,

YIb-HUyT (Soft Clip)7” Fu s AJifs
BEBEIE., XRMROFEZ@BAT=7) v
EVTIREBTVRNEREZEE T,
(V7 Vw2t icd e HDI1/O
X7V T RA Y NETDA4IBZILD T,
4dB DNy R)V—L7ZWR L E T, —KFH
EME IR TDICKRIBEET,

H=TJ (Curv)V 7 h=— U I v Zx—[alE
EHEoTANEINEZTFa /G52 BEE
#HEF, cFA Ty bADBARDAE
WEZEEN—FRIZELHBEVWA—IR—=YV T | -
VIvT VI RBAELET,

[FIFIW] A=Y

(IN—FRTT7&RE] BAT7a 7D [FY
Z)V] 27 TE. HD /O A VA =)L &
NEFI2)V 10 h— RO 4Ty bk
T3—<v R & [YUTILL— b EE] BRE
TEX9d,

FIENWVIO A= RP1IDETA VA +—
WENTWVEEER [FIYIL] BTH1D
FLRENET, 2DDHD /0 T ZIVILIE
H—RKWA VA R=ILENTWBEEER [T
JHI1-8] BT L [FIYFIL9-16] X TH
FRENET, [FYYI] (B—R1K) X7,
FE[FYIL1-8]1 2T L [FIH)L 9-16]
(B—R2#) [Ckb. HDI/IOFT Y &IV « J1—
RAEEDZFNFNDA Ty MK UTIH
Carybra—h&rEnEd, HDI/OT
VEIWVHEED— RN A VA R=)bENT
WEWEEIZ, TS0 TR RENE
Ao

ety Sex T Defait o2

HD /IO DI\— RO 7/E. [TIFI] X—T

Y 48kHz 2 A 59 > TV L — kT,
SIMUXA 77 4« AV EHHL T3
HGxEBRE, HDI/OT VX I) « H— KD
TDIFA > 7w b &A 7T ¢ 1)V (ADAT
S/IMUX) D8 DDTXTDA YT FD
YL — FEBRHBEHBINICE VI
"D %9,
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FIGN e TFH=Iv b

HD 1/O YRV IH—FRDTFI X)L -

Tr—<v rEENLET, YTV —

MCEoTTFIRIL s Tx—< v bDF TS

vavRBEEVET,

Peripherals
) Interface HB IO
= HD IO #1
Main Al it |
AHD MAD! DigLink 1 e
Digital Farmas Samgile Rate Comveesion
@ arsyon Oz
() ADAT 1-8 L ena-a
HD Care PCle #1, Bxp or §

Clack Source: Oenz-s
interna )
Loop Master: HD OMNI #1

Sample Rate:

AL )

HD /O D \— Y = 7&RE]F (77 05.44.1kHz

TOD [FIFI T4x—v N T3y

Peripherals
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Appendix A: Compliance Information

Environmental Compliance

Disposal of Waste Equipment by Users
in the European Union

X
iy

This symbol on the product or its packaging indicates that this
product must not be disposed of with other waste. Instead, it
is your responsibility to dispose of your waste equipment by
handing it over to a designated collection point for the recycling
of waste electrical and electronic equipment. The separate
collection and recycling of your waste equipment at the time of
disposal will help conserve natural resources and ensure that
it is recycled in a manner that protects human health and the
environment. For more information about where you can drop
off your waste equipment for recycling, please contact your
local city recycling office or the dealer from whom you purchased
the product.

Proposition 65 Warning

This product contains chemicals, including lead, known
to the State of California to cause cancer and birth defects
or other reproductive harm. Wash hands after handling.

Perchlorate Notice

This product may contain a lithium coin battery. The State of
California requires the following disclosure statement: “Perchlorate
Material — special handling may apply, See
www.dtsc.ca.gov/hazardouswaste/perchlorate.”

Recycling Notice

4y
e

EMC (Electromagnetic
Compliance)

Avid declares that this product complies with the following standards
regulating emissions and immunity:

¢ FCC Part 15 Class A

EN55103-1 E4

EN55103-2 E4

AS/NZS CISPR 22 Class A

CISPR 22 Class A

FCC Compliance for United States

Communication Statement

Note: This equipment has been tested and found to comply with
the limits for a Class A digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference when the equipment
is operated in a commercial environment. This equipment
generates, uses, and can radiate radio frequency energy and,
if not installed and used in accordance with the instruction
manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to
cause harmful interference in which case the user will be
required to correct the interference at his own expense.

Any madifications to the unit, unless expressly approved by Avid,
could void the user's authority to operate the equipment.

Argentina Conformity

JAN

TV
Rheinland
Argentina S.A_
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Australia and New Zealand EMC

Regulations Safety Compliance
Safety Statement
G N1705 This equipment has been tested to comply with USA and Canadian

safety certification in accordance with the specifications of UL
Standards: UL60065 7th /IEC 60065 7th and Canadian CAN/CSA
Canadian Compliance C22.2 60065:03. Avid Inc., has been authorized to apply the
appropriate UL & CUL mark on its compliant equipment.
This Class A digital apparatus meets all requirements of the
Canadian Interference-Causing Equipment Regulations. -
Warning
Cet appareil numérique de la classe A respecte toutes les
exigences du Reglement sur le material brouilleur du Canada.

European Union Declaration of
Conformity

(EMC and Safety)

RISK OF ELECTRIC SHOCK
DO NOT OPEN

c € . Important Safety Instructions
Avid is authorized to apply the CE (Conformité Europénne) mark 1) Read these instructions.
on this compliant equipment thereby declaring conformity to EMC
Directive 2004/108/EC and Low Voltage Directive 2006/95/EC. 2) Keep these instructions.
Korean EMC Regulations 8) Heed all warnings.
4) Follow all instructions.
LIS S FXIGHMAI2: ol HHl= 4 UXRIMSS HEEMCESS Y ) .
oirt. 210] A= 5|A BONEIAL TOISIE! Q Hole, 7H ALS 5) Do not use this equipment near water.
2 93 SUE FHHIS el 22E RSt 6) Clean only with dry cloth.

7) Do not block any ventilation openings. Install in accordance
with the manufacturer’s instructions.

8) Do not install near any heat sources such as radiators, heat
registers, stoves, or other equipment (including amplifiers) that
produce heat.

9) Do not defeat the safety purpose of the polarized or grounding-
type plug. A polarized plug has two blades with one wider than the
other. A grounding type plug has two blades and a third grounding
prong. The wide blade or the third prong are provided for your
safety. If the provided plug does not fit into your outlet, consult
an electrician for replacement of the obsolete outlet.

10) Protect power cords from being walked on or pinched
particularly at plugs, convenience receptacles, and the point
where they exit from the equipment.

11) Only use attachments/accessories specified by the
manufacturer.

12) For products that are not rack-mountable: Use only with a cart,
stand, tripod, bracket, or table specified by the manufacturer,
or sold with the equipment. When a cart is used, use caution when
moving the cart/equipment combination to avoid injury from tip-over.
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13) Unplug this equipment during lightning storms or when unused
for long periods of time.

14) Refer all servicing to qualified service personnel. Servicing
is required when the equipment has been damaged in any way,
such as power-supply cord or plug is damaged, liquid has been
spilled or objects have fallen into the equipment, the equipment
has been exposed to rain or moisture, does not operate normally,
or has been dropped.

15) For products that are a Mains powered device:

The equipment shall not be exposed to dripping or splashing
and no objects filled with liquids (such as vases) shall be placed
on the equipment.
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Warning! To reduce the risk of fire or electric shock, do not expose
this equipment to rain or moisture.

16) For products containing a lithium battery:
CAUTION! Danger of explosion if battery is incorrectly replaced.
Replace only with the same or equivalent type.

17) For products with a power switch:
The main power switch is located on the front panel of the HD I/O.
It should remain accessible after installation.

18) The equipment shall be used at a maximum ambient
temperature of 40° C.
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